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Wat zijn Interactive Schedule?

Hoe maak ik een Interactive Schedule?

 instellen
« Opmaak
- opslaan en afdrukken

Interactive Schedules in de praktijk:

« massastudies
« ramen en deuren borderel
- meetstaten

Vragen.....?
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WAT ZIJN INTERACTIVE SCHEDULES?



Interactive Schedules
Wat zijn Interactive Schedules?

Weergave mogelijkheid van het model in de vorm van lijsten.

Input is output

Om in lijsten een betrouwbare output te kunnen genereren moet het model uiteraard goed opgezet zijn. Maar ook met
een minder goed opgezet model kunnen Interactive Schedules een grote hulp zijn om bijvoorbeeld fouten op te sporen.
Deze kunnen dan deels direct in de lijst gecorrigeerd worden.

Noot:
In ArchiCAD bestaan ook ‘Lists’, waarmee 00Kk lijsten opgeroepen kunnen worden. Dit is een oudere techniek
en wordt niet veel meer gebruikt. Beperkingen hiervan ten opzichte van de Interactive Schedules zijn:

* het is een momentopname

* er kunnen geen projectwijzigingen in doorgevoerd worden

* het instellen is veel complexer

* de opmaakmogelijkheden zijn zeer beperkt
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Interactive Schedules
Mogelijkheden van Interactive Schedules

*Controleren van het model
Staan alle elementen op de juiste laag en corrigeer dit direct

* Wijzigen van element eigenschappen
Voeg eenvoudig eigenschappen toe of wijzig bestaande eigenschappen

*Selecteren van elementen in het project
Kijk direct waar deze elementen staan op plattegrond of in 3D.

Bij TeamWork projecten kunnen de elementen zo ook eenvoudig gereserveerd worden.

*Zoeken op en controleren van IFC eigenschappen
Belangrijk bij het uitwisselen in BIM projecten

* Uittrekken van hoeveelheden
Te gebruiken voor meetstaten en eenvoudig te exporteren naar excel

=i

2

Select on Floor Plan

Select in 3D
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Interactive Schedules
Oproepen en Openen

Openen Interactive Schedules
Het openen kan op een van de volgende manieren:

* Dubbel-klik in de Project map > Schedules op de gewenste lijst

*Dubbel-klik in de View map op een als view opgeslagen Schedule

*Het menu Document > Schedules and Lists > Schedules > Keuzelijst van de Schedules
*Vanuit de Scheme Settings

Openen Scheme Settings
Het openen kan op een van de volgende manieren:
*De knop ‘Scheme Settings..." in een opgeroepen Schedule

*Het menu Document > Schedules and Lists > Schedules > Scheme
* Contextmenu (rechter muisklik) op Schedules in de Navigator > Project Map of View Map
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INSTELLEN INTERACTIVE SCHEDULES



Instellen Interactive Schedules
Scheme Settings

De Scheme Settings bestaan uit 3 onderdelen: WEaBaBa T ——
¥ Schemes
*Schemes
Hierin worden de verschillende lijsten georganiseerd. ITip bekijk ook de Meetstaatmodu [ Create New... ]
Checklist objecten
«Criteria £} Checklist wanden [ Duplicate... ]
Hierin wordt bepaald van welke ArchiCAD elementen gegevens g:z:::;;s‘:ande" per vendizping [ Rename. .. ]
verzameld worden. Het hele model wordt gefilterd totdat alleen de Elektra per zone
elementen overblijven waarover de Schedule moet gaan. Kozijnstaat gespiegelkde merken ci [ Belete ]
& Kozijnstaat visuele controle [ Import... ]
*Fields Ramen en deuren binnen
Hierin wordt bepaald welke gegevens getoond worden. & Ramen en deuren buiten [ Export... J

Zonoac mD) nar catanario

> Criteria / Ramen en deuren buiten

» Fields / Ramen en deuren buiten

| Cancel | [ oK |
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Instellen Interactive Schedules
Nieuwe Schemes

Het toevoegen van nieuwe schemes werkt als volgt: e A0 S chedule Scheme e D OGS
*Create New.... items: | & Construction Ele... + | |
Kies hierbij voor bij Items voor: ID: ¢ [ Construction Elements ~ Staatmodu [ | Create New... |
« Construction Elements [ &l Components ( Duplicate... ]
Voor alle basiselementen R erdieping ( . ]
lnew scheme ’ ename...
*Components . [ Delete ]
Speciaal voor informatie over elk onderdeel van [ Cancel ] [ oK ] t merken ct
composieten -:‘0"* ( Import... ]
n [ Export... ]
*Duplicate...
Maak gebruik van een bestaande Scheme en pas deze =
daarna aan.
in
*Import... | Cancel | [ OK |

Vanuit andere projecten kunnen of de KeyMember modules
kunnen eenvoudig bestaande Schedules toegevoegd
worden.
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Instellen Interactive Schedules
Criteria instellen - basis

Het filteren van de elementen waarvan de Schedule gegevens moet 0.0.06 Scheme Settings
gaan verzamelen: » Schemes

¥ Criteria / Ramen en deuren buiten
1. 'Element Type’

Dit is een verplicht onderdeel (Slab, Walls, All Types, etc). Ny ( Element Tyi:te"ais Al Doo\:?'l.::es ) :'d/or
: Element Type is EH All Window Types ) and
2. Extra criteria: Add-knop = Layer is 21 Buitenwanden
Voor verdere specificatie: kies het criterium en stel de waarden in.
De mogelijkheden hangen af van het gekozen criterium
[ Add v] [ Remove ]

» Fields / Ramen en deuren buiten

[ Cancel ] [ ok |

( Criteria Value ) land/or
s ( Element Type is B All Door Types or
: Element Type is H All Window Types ) and
= Layer is 21 Buitenwanden and
+|  »|/Elevation to... »|= »| 0,00 L
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Instellen Interactive Schedules
Criteria instellen - verder uitwerken

Het filteren van de elementen waarvan de Schedule gegevens moet
gaan verzamelen:

( Criteria Value ) andjor
( Element Type is <3slab and p
. s Layer is 23 Vioeren ) or
° Haakjes 3 Element Type is & Roof and
Groepeer criteria die bij elkaar horen, zodat complexere criteria | (BT O I 7 0211 o)
overzichtelijk blijven. S
)}
° And/or Element Type is <35lab and
Met deze optie kan een gelijktijdigheid van de verschillende Layer s 23 Vloeren
voorwaarden aangegeven worden Element Type is Bslab or
Layer is 23 Vloeren

* Parameters en IFC Properties toevoegen
Via het kleine pijltje bij de Add-knop

Bij bibliotheek-elementen (Objecten, Ramen, Deuren, etc) kunnen
parameters van deze objecten als criteria worden toegevoeqd.

Aan alle elementen kunnen IFC eigenschappen worden toegevoeqd
en hiermee kan daar op gesorteerd worden. [ Add S Remove

~— . Add Object Parameters
__F Field: Add IFC Properties

[ Cancel ] F—N—q
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Instellen Interactive Schedules
Fields instellen - kiezen van informatie

* Welke informatie tonen TSN O R 1 1 .
Sleep de gewenste Parameters van links naar rechts of gebruik de T T
Add-knop

» Criteria / Ramen en deuren binnen

) ¥ Fields / Ramen en deuren binnen
Zwart = niet aanpasbare parameter

Blauw = in de Schedule aanpasbare parameter Available Parameters: Schedule Fields:
Uitgegrijsd = deze parameter is reeds geselecteerd » R General L i
v E Window/Door + R Quantity 1
. Ef 2D Symbol + H View from Opening Side |
L]
P,a’?]"‘te:ffs e“__':? E_’_‘;Pe;tc;;skt°e"°eqe" £ 3D Front Axonometry : F@ 2D Symbol !
Via het kleine pijltje bij de “Knop EH Acoustic Rating + N Library Part Name 1
EH Egress Dimensions + H width 1
Bij bibliotheek-elementen (Objecten, Ramen, Deuren, etc) kunnen B Fire Ratina + E Height 1l
parameters van deze objecten als criteria worden toegevoegd. g r- - .+ B FireRating !
EH From Zone Number
. Height
Aan alle elementen kunnen IFC eigenschappen worden toegevoegd & e ) .
) EH Leaf Dimensions
en hiermee kan daar op gesorteerd worden. B Marker Text
[ Nominal W x H Size
* Volgorde informatie aanpassen EH Nominal W x H x T Size
Gebruik de pijltjes voor de parameters (Schedule Fields) om de EE Nominal WLD Ooanine Helakt. oo 4
volgorde aan te passen. " , o _
s = ( Add v|| Remove |

[ Cancel J E—OK—J
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Instellen Interactive Schedules

006, Additional Object Parameters
Fields instellen - extra parameters Select Objectby:  (JFavorite Objects ;|
Search Obj
. . . arch Doled Folder View
Tips om de parameters van objecten snel te vinden: £ o Folder View (used Objects only)
1. Kies de juiste methode bij ‘Select Object by": 25 Boom o Search criteria
1. Folder View: alleen indien de andere mogelijkheden niet passen aanzic. WEEES 17 ¢ Favorite Objects
2. Folder View (used Objects only): alleen gebruikte objecten komen in de lijst . D d - 4 LJ
. . . Hemelob R1 Schakela  Spotje Toilet Zon
3. Search criteria: als je naam van de gezochte parameter weet ject17.. 17.gsm ar17+.. plafon... 17.gsm object...
4. Favorite Objects: alleen objecten die ook als favoriet zijn ingesteld F ‘I
Zoh
.. .. . . object ...
2. Kijk vooraf bij de objecten hoe de parameters of IFC properties heten
3. Organiseer de Available Parameters door op de titel te klikken
Available Parameters: Selected Parameters:
Variable A Type Name Variable Type Name
A %3 Dimensie
ArmchairDepth ¢ Diepte stc
ArmchairWidth ¢33 Breedte st
B %3 Dimensie
BottomSofa Abc  Zitplaatse
BottomSofa... §: Breedte b:
CoffeTable Koffietafe
FM_Ir ... Abc Inv is

FM_ObjectW... } Gewicht
FM_ObjectW... abc Gewichtse

[ >>Add>> ][ Remove ]

[ Cancel ] [ ok |
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Instellen Interactive Schedules
Fields instellen - verder uitwerken

Selecteer de betreffende parameter(s) en verfijn de instellingen door de volgende keuzen te maken:

eSorteren
Het pijlteken geeft aan of de gegevens op- of aflopend gesorteerd worden. D
®Totalen
Hoeveelheden: Het somteken (Z) geeft aan van welke parameter(s) het totaal van de optelling van de hoeveelheden wordt @ D
gemaakt.

Aantallen: Het somteken 1 (1) geeft aan van welke parameter(s) het totaal van het aantal wordt gemaakt.

eSubverdeling en subtotalen
De vlag geeft aan over welk onderdeel een subverdeling (en subtotaal) wordt gemaakt. D
Plaats deze bijvoorbeeld achter de verdieping (Home Story), dan wordt per verdieping een subverdeling gemaakt.

Schedule Fields:

4 [Y4 Zone Category 1 e
+ R Floor (Story) 13

4 44 Room Number 1

¢ [Y4 Room Name 1

4 [Y4 Measured Area 1z
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Opmaak Interactive Schedules

Opmaak - algemeen Style: Records by Rows -
Show uniform items as a
De opmaak van Interactive Schedules kan op diverse plaatsen ingesteld worden: LR
Show headline [ Settings... I
¢ De Interactive Schedule zelf @pply Format Options to})
Kolombreedte, rijhoogte, teksten Entire Schedule -
. .e . Font: V/ Arial v
* Het menu aan de linkerzijde van een gegeneerde Interactive Schedule
Indeling, tekstformaat, opmaak afbeeldingen Encoding: Westers v
M1 20,00 mm
Tip: o . M1 400 mm
Aan de onderzijde zit een Cancel/Redo functie voor de opmaak.
* Project Preferences Font Pen: ¥y (1m
Eenheden en nauwkeurigheid van de hoeveelheden en maten Font Style: [Z]@
Cell Border: No border v
Getrokken lijn » ‘
Border Pen: L ‘
[ Footer Settings... ]
Cancel/Redo ) ||
Format Change: 7 ()| =z (=

KUBUS




17

Opmaak Interactive Schedules
Opmaak - kolombreedte en rijhoogte

Voor het aanpassen en instellen van de kolombreedte zijn drie mogelijkheden beschikbaar:

*Dubbelklik op het kolom- of rijscheidingsteken

. . . 50 3 .
De breedte of hoogte wordt automatisch aangepast aan de inhoud. +
* Verschuif het kolom- of rijscheidingsteken in de liniaal 0 0 O Schedule Cell Size
Ga met de cursor boven het scheidingsstreepje staan totdat de cursor verandert en sleep de kolom of rij op
de juiste breedte of hoogte. Column Width (mm)
Left Margin 2,00
A Categorie 18,00
*Numeriek _'_:J Verdieping 20,00
Roep via de 3-puntsknop (naast de liniaal) het'Schedule Cell Size' venster op. Nr. 10,00
Per type kolom of rij kan hier een vaste waarde worden ingegeven. Alle kolommen krijgen dan automatisch Naam 19,00
d lfde breedte. die uit d lat | kol . ¢ Getekend opp. 23,00
ezelfde breedte, die uiteraard later wel per kolom weer is aan te passen. Berekend opp. 30,00
Row : Height (mm)
Top Margin 2,00
Main header 5,00
- 1 L] 1 1 L] 1 L] 1 L] 1 L] 0 1 L] 1 1 ’
I - Meeverlh T ¥ T Header row 1 5,00
| Zones per categorie Headline separator 6,00
E Categorie Verdieping Nr. Naam Getekend opp.  Berekend opp. Headline 5,00
1 Value row 4,00
| Verbliffsruimte Grand total row 26,00
- Begane grond  <rui... <naam zone> 991 9.91
_: Begane grond <rui... <naam zone> 13,44 1344
) Begane grond  <rui... <naam zone> 1541 1541

38,76 m? 38,76 m? | Cancel | [ OK |
KUBUS
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Opmaak Interactive Schedules
Opmaak - indeling

*Liggende of staande lijst

Maak aan linkerzijde bij 'Style’ de keuze: Style: Records by Rows -
*'Records by Rows': staande lijst - Fields als kolomkop [i7] Show uniform items as a
*'Records by Columns’ : liggende lijst - Fields aan zijkant iR
Show headiine Settings... ]
* Koptekst
De naam van kolom- of rij koppen kan aangepast worden door op de zogenaamde Column header @y 0w e g m m mwg w
of Main header in de Schedule te gaan staan en de tekst aan te passen. In de Scheme Settings blijft §[2°"eca‘eg°ﬁeglur, AU —
de oorspronkelijke parameternaam staan. I

* Gelijke elementen wel/niet samenvoegen
Vink 'Show uniform items as a single entry’ aan of uit

Als twee of meer elementen precies dezelfde waarden hebben worden deze samengevoeqgd tot één
regel. Het aantal (Quantity) verandert dan mee. Als deze optie is uitgevinkt komen alle objecten
apart onder elkaar te staan.

Let op!

Of twee elementen gelijk zijn, wordt door ArchiCAD bepaald op basis van de ingestelde
parameters voor de betreffende Schedule! Een 2D symbool of aanzicht telt daarbij niet
mee; ArchiCAD kan niet bepalen of twee symbolen of aanzichten gelijk zijn of niet.

KUBUS




Opmaak Interactive Schedules
Opmaak - indeling

Om meer overzicht in de gegevens te krijgen kunnen een of meer van de gekozen parameters als
kopteksten in de verdeling worden toegevoegd met de functie ‘Show Headline'. De waarde van de
eerste velden komt als hoofdregel boven iedere verdeling. Hierbij zijn de volgende instellingen
mogelijk via de knop 'Settings...".

* Aantal velden
'‘Source of the headline': maximaal het aantal ingestelde velden -1

*Een extra regel wit
Vink ‘Insert separator row before headlines’ aan.

*Omschrijving van het veld

te

ZOC-3 Zone categorie overzicht

Vink ‘Add header text to headlines as prefix' aan. De omschrijving komt dan voor de waarde
staan.
Let op! e
Aanpasbare parameters die als headline worden gebruikt zijn dan niet aan te sorine
passen. Vink of deze optie even uit of gebruik een anders Interactive Schedule %H
voor het controleren en aanpassen. e

Verdieping Nr.
Begane giond 03
1

Begane giond 02
2everdieping 12
2

Begane giond 04
Begane giond 06
te verdieping 09
teverdieping 10

te verdieping 08
2everdieping 11
5

12

Style:

Show headline

19

Records by Rows

Show uniform items as a
single entry

_Headline Settings

Source of the headline:
[ The first two schedule fields

[2] Insert separator row before headlines

[ | Add header text to headlines as prefix

4r

Naam
Sanitair

Berging
Zolder

Keuken
Eetkamer
Slaapkamer
Leefkamer

Hal
Doorloop
Hal
Overloop
Overloop 2

Getekend opp.

328m
10,15
5423
6438 m*
1069
3727
3727
3721
12250m*
248
203
51,19
2594
2455
1319 m*

303,35 m*

[ Cancel J W

ZOC-3 Zone categorie overzicht

Verdieping Nr.  Naam Getekend opp.
Badruimte

Beganegond 03 Sanitair 328

1 328mt
Bergruimte

Begane giond 02 Berging 10,15

2everdieping 12 Zoider 5423

2 64,38 m?
Verblijfsruimte

Begane giond 04 Keuken 1069

Begane giond 06 Eetkamer 3727

teverdieping 09 Slaapkamer 3727

te verdieping 10 Leefkamer 3727

4 12250 m*
Verkeersruimte

Beganegrond 01 Hel 248

Begane giond 05 Doorloop 903

Begane giond 07 Hal 51,19

Teverdieping 08 Overloop 2594

2everdieping 11 Overloop 2 2455

5

KUBUS

n319m?

303,36 m*




Opmaak Interactive Schedules
Opmaak - teksten en lijnen

Voor elk type regel kan een aparte opmaak worden ingesteld door deze regel te activeren selecteren in de
schedule of het type te kiezen bij ‘Apply Format Options to:'.

Tip:

Kies eerst ‘Entire Schedule’ om instellingen die voor alle types moeten gelden in te stellen.

 Lettertype

Met de bekende keuzen: pen en stijl (vet, cursief, onderstreept)

*Hoogte van de rij

Vast rijhoogte. Een passende rijhoogte is in te stellen via dubbelklikken op de rijseperatieteken van de

Schedule zelf.

*Grootte van de tekst

M].

M1

Style: Records by Rows v
Zhnzg L:‘i;oyrm items as a

Show headline I Settings... l
@pply Format Options to})

Entire Schedule v
Font:  Arial -
Encoding: Westers -
M1 20,00 mm
M1 4,00 mm
Font Pen: L @

Font Style: E]@

Cell Border: No border A
Getrokken lijn » J

Border Pen:

Cancel/Redo &0 Ea)

Format Change:

20
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Opmaak Interactive Schedules
Opmaak - teksten en lijnen

Style: Records by Rows -
*Tekst passend in de cel (] Show uniform items as a
Met ‘Wrap text’ lopen teksten die breder zijn dan de kolom automatisch door naar een volgende regel. SIS
Show headline I Settings... l
« Uitlijnen @pply Format Options to)
Met ‘Align Column’ kunnen de kolommen links, midden en rechts uitgelijnd worden. De vierde optie is ‘Align Entire Schedue M
by Decimal marker’ waarmee uitgelijnd kan worden op basis van de plaats van de komma. Font: « Avial -
Encoding: Westers -
o M1 20,00 mm
Align Column: = = M1 ppn -
- Omtreklijn
Kies bi Cell Border aan welke zijde(n) een lijn gewenst is inclusief lijntype en pen. Font Pen: ¥ - ]

Font Style: E]@

Cell Border: No border -
Getrokken lijn >J
Border Pen: [ |
[ Footer Settings... ]
Cancel/Redo f‘) [
Format Change:

KUBUS




Opmaak Interactive Schedules

Opmaak - afbeeldingen

Kies bij ‘Apply Format Options to:" voor 'Preview’ of ga op een afbeelding in de Schedule staan en maak de
volgende keuzen:

*Pennen
*Overnemen van het symbool: vink ‘Enable Object's Pens’ aan
* Qverschrijven: Kies de gewenste pen

* Schaal
*Op schaal: Stel de gewenste schaal zoals gebruikelijk en leg deze vast in de filters van de View
* Passend in de cel: Vink de optie 'Reduce preview to fit into cell' aan. Het symbool wordt verkleind als het
groter is dan de cel.

* Maatvoering (alleen ramen en deuren)
Als in de Schedule ramen en/of deuren staan ) kan de optie ‘Add automatic dimensions' aangevinkt worden. De
instellingen van het Maatvoeringsgereedschap worden gebruikt voor de automatische maatvoeringslijnen.
Kies bij ‘Dimension Settings..." de gewenste afmetingen en positie van de maatlijnen.

*Omtreklijn voor de cellen

Apply Format Options to:
| Preview

4r
-

(M Enable Object's Pen

Wiss |[Im

Contour Pen:

[ | Reduce preview to fit into cell
Align preview to:
| Center ;]

[QAdd automatic dimensions

[ Dimension Settings... J

Cell Border: | All borders ™
Getrokken lijn »
Border Pen: ¥ ss |E|

KUBUS
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Opmaak Interactive Schedules
Opmaak - afbeeldingen

Extra informatie toevoegen
Aan een afbeelding in de Interactive Schedules kan aanvullende informatie toegevoegd worden.

Open de afbeelding op een van de volgende manieren:
*Klik op een afbeelding en vervolgens op de knop ‘Annotate’
*Dubbelklik direct op een 2D symbool om het Annotate venster te openen.

Voeg vervolgens met 2D gereedschappen informatie aan het symbool toe.

Let op!
De opzet van de Schedule mag naderhand niet meer gewijzigd worden! Bij bijvoorbeeld een A
andere sortering gaan de annotaties verloren. .

—me RIS A

1 Bek ARTIPONT 4w

Let op!
De aanpassing geldt alleen voor de betreffende Interactive Schedule (vergelijkbaar met
toegevoegde informatie aan gevel, doorsneden en andere vensters)

KUBUS




Opmaak Interactive Schedules

Opmaak - eenheden

*Ingestelde maten

Project Preferences

24

Project Preferences

Neemt de instellingen bij Project Preferences »
Dimensions over. Dit is in te stellen per View.
Bijvoorbeeld hoogte en dikte van wanden.

*Berekende en getekende maten

De notatie van deze lengteafmetingen,
oppervilakten en volumes in de Interactive
Schedules wordt bepaald door de instelling bij
Project Preferences > Calculation Units & Rules

]_

[ Calculation Units & Rules :] [ << Previous ] [

Next >> ]

[ Dimensions :] << Previous [ Next >>
| Store as... |
DIN
Millimeter
Millimeter + extra decimaal

Millimeter zonder decimalen

[ [sr] 97| ¥ aliwate] 7| sample:

Linear Dimensions

Unit: [ centimeter v ]

Decimals: E]
Extra Accuracy:

|| Hide Zero Wholes || Hide Zero Decimals
Witness Line Scalability: () Scaled
() Fixed
| Cancel | [ ok |

#% Length Unit:

ar
_J

meter

—_—

Decimals: [:]
Extra Accuracy:

<> Area Unit: [ square meter :]
Decimals: E]
Extra Accuracy:

@ Volume Unit: [ cubic meter :]
Decimals: E]
Extra Accuracy:

5% Angle Unit:

Decimals:

—
ar
_J

decimal degrees

[

Note: Calculations using Graphic Templates will override these settings.

Calculation Rules... ]

| Cancel | [ oK |

KUBUS
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Opmaak Interactive Schedules
Opmaak - tips

* Kleurcodering

Om tijdens het werken aan Schedule een goed overzicht te kunnen behouden tussen de verschillende type Schedules, kan een
kleur codering aan de Schedule toegevoegd worden:

Activeer bij ‘Apply Format Options to:" ‘Entire Schedule’ en wijzig de Font Pen.

Voorbeeld:
Als alle teksten groen zijn, betekent dit het een lijst is voor de controle van het model.

*Bewerken als losse tekst

Schedules kunnen naar een Worksheet gekopieerd worden, om daar als losse lijnen en teksten bewerkt te worden. Dit is met
name bruikbaar als deze 2D symbolen bevatten.

Activeer de Schedule en kies Edit > Copy en kies Edit > Paste op de Worksheet.

Voorbeeld:
Maak van een lijst met alle gebruikte objecten een renvooi.

KUBUS
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Opslaan en afdrukken
Opslaan

De tabellen worden in het project zelf opgeslagen. Voor het gebruik buiten het project zijn er de volgende mogelijkheden:

*Scheme gebruiken in ander ArchiCAD project
*Ga naar de Scheme Settings
*Selecteer de Scheme
* Kies voor ‘Export’.
*Sla het bestand (*.xml) op een handige locatie op.
Met ‘Import’ kan een Scheme vervolgens in een ander project binnengehaald worden.

*Schedule gebruiken in ander pakket
Om gegevens verder te bewerken buiten ArchiCAD, kan de tabel worden opgeslagen als tekst- of spreadsheetbestand (Excel) of
als pdf-bestand:
* Activeer de Schedule
*Ga naar File > Save as en kies het gewenste bestandsformaat.

Tip:
Neem veel gebruikte Schedules op in de bureautemplate. Ze zijn dan automatisch beschikbaar in elk nieuw project.

KUBUS
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Opslaan en afdrukken
Afdrukken

Het afdrukken van Interactive Schedules werkt hetzelfde als voor andere venster in ArchiCAD.

Direct Printen
Een tabel kan direct afgedrukt worden naar de printer via File > Print...

Op een layout plaatsen
*Maak een View aan

Via de Organizer of ga in de Navigator > Project Map op de Schedule staan, klik met de rechtermuisknop en kies ‘Save Current
View...'

*Plaats deze View op dezelfde wijze op een Layout als de overige Views.

Deze wordt direct gelipdatet met andere drawings (zelf in te stellen met Update type). De schaal van de view is belangrijk om de
symbolen (previews) op schaal te zien.

KUBUS
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Massastudies
Morph Tool

Sinds ArchiCAD 17 kan het oppervlak en volume van een Morph per verdieping bepaald worden.
Stel
[NONON - N < | (11711 ——

_» Schemes
¥ Criteria / ONT-01 Massastudie

L Criteria | Value ) land/or|
B Element Type is & Morph
( Add v|[  Remove |

¥ Fields / ONT-01 Massastudie

Available Parameters: Schedule Fields:
» R General + R Home Story 1~
» g Morph s kD 1
+ & Area (by Story) 1z
+ & Volume (by Story) 1z
.
( Add v|[ Remove |
Cox )

30
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Massastudies
Zone Tool

De zonetool kan ook gebruikt worden voor massa studies.

Verschillen met de Morph Tool:

Voordelen:
*meerdere categorieen
*meer eigenschappen
*meer geschikt voor gebouwniveau
*rechthoeken oprekbaar met behoud van oppervliak
*meer informatieweergave op plattegronden

Nadelen:
* tekenen per verdieping
e alleen zichtbaar op verdieping waarop getekend is
*niet zichtbaar in doorsneden en gevels
e vrij vormgeving met SEO
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Zones per verdieping

Ve... Nr. Categorie Nr. Naam Getekend opp. Berekend opp.
Gelijkvloers
010 Horz. Circulatie <nr> <zonenaam> 53,82 61,86
53,82 m? 61,86 m?
020 Verticale circulatie <nr> <zonenaam:> 8,04 8,04
8,04 m? 8,04 m?
030 Natte cel <nr> <zonenaam> 39,81 70.19
39,81 m? 70,19 m?
050 Technische lokal... <nr> <zonenaam:> 30,38 30,38
050 Technische lokal...  <nr> <zonenaam> 83,53 83.53
113,91 m? 113,91 m?
070 Sociale activiteiten <nr> <zonenaam> 131,01 85,14
131,01 m? 85,14 m?
1e verdieping
010 Horz. Circulatie <nr> <zonenaam> 53,82 61,86
53,82 m? 61,86 m?
020 Verticale circulatie <nr> <zonenaam> 8,04 8,04
8,04 m? 8,04 m?
030 Natte cel <nr> <zonenaam> 18,63 70.19
18,63 m? 70,19 m?
050 Technische lokal... <nr> <zonenaam:> 51,56 30,38
050 Technische lokal...  <nr> <zonenaam> 83,53 83.53
135,09 m? 113,91 m?
562,17 m? 593,14 m?
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Ramen en deuren borderel
Ramen en deuren coderen (merken)

Met behulp van de Interactive Schedule kan eenvoudig een overzicht gemaakt worden van alle ramen en deuren in project. Voor
een nauwkeurig en volledig overzicht worden de volgende stappen doorlopen:
In de Key Member template is deze werkmethodiek al opgenomen:

*Codering ¥ [_jRamen en Deuren lijst
view: 1a Buitenkozijnen merken v _jRamen en deuren merken
view: 1b Binnenkozijnen merken 1a Buitenkozijnen merken
*Op basis van de gekozen criteria wordt gecontroleerd of ramen en deuren gelijk zijn 1b Binnenkozijnen merken

2 Gespiegelde merken checken
3 Visuele controle

) Deurenlijst
e Controle gespiegelde merken Ramen en deuren binnen

view: 2 Gespiegelde merken checken Ramen en deuren buiten
* Alle ramen en deuren worden nu ook gecontroleerd op de wijze van plaatsen
*Pas waarnodig de naamgeving aan

*Geef de ramen en deuren een ID

*Visuele controle
view: 3 Visuele controle
* Alle ramen en deuren worden nu apart weergegeven om te controleren of ze echt gelijk zijn
* Pas naamgeving waarnodig aan
* Gebruik deze stap ook altijd nadat het model gewijzigd is

L=
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Ramen en deuren borderel
Ramen en deuren weergave

*Overzichtlijsten ¥ _jRamen en Deuren lijst
view Deurenlijst ¥ [_jRamen en deuren merken
view Ramen en deuren binnen 1a Buitenkozijnen merken

1b Binnenkozijnen merken
2 Gespiegelde merken checken
3 Visuele controle

Deurenlijst

view Ramen en deuren buiten
Kies een van de meegeleverde lijsten en pas waar nodig aan.

* Maatvoering Ramen en deuren binnen
Als in de Schedule ramen en/of deuren staan ) kan de optie Ramen en deuren buiten
‘Add automatic dimensions’ aangevinkt worden. De noo schedule £ Destentit _ ‘
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MEETSTATEN VOLGENS VMSW
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Meetstaten VMSW

Tabel toevoegen aan ArchiCAD

Aan elementen kunnen IFC codes worden toegevoegd. Dit kan handmatig of vanuit een keuzelijst.

NIEUW: VMSW coderingstabel
Nieuw voor Key Members is een keuzelijst met de VMSW codering. Deze kan binnenkort vanaf onze website gedownload worden
en zal vanaf ArchiCAD 18 aan de Key Member module zijn toegevoeqgd.

Installeren VMSW coderingstabel
Voeg het bestand toe aan:
@ C\Users\[username]\Graphisoft\IFC Rules 17.0.0 NED\
(bestaat deze folder niet, plaats het bestand dan in: C:\Program Files\Graphisoft\ArchiCAD 17\Defaults\IFC Rules\ )

Macintosh HD>Gebruikers>[gebruikersnaam]>Bibliotheek>Application Support>Graphisoft>IFC Rules 17.0.0 NED»>

Gebruiken coderingstabel
De extra coderingstabellen zijn beschikbaar bij Element Selection > Default Settings > Tags and Categories > Manage IFC
Properties...> Apply Predefined Rule:

* Kies bij Select Rule voor VMSW Coderingstabellen

* Kies daaronder een codering

*Kies in de boomstructuur de juiste code.

Uitgebreide uitleg over het gebruik staat in T&&076 Elementcodering toevoegen aan een ArchiCAD-BIM model
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